
Montaža

O čem govori to poglavje

Ko zaključiš s snemanjem, preideš v fazo montaže. Za to lahko uporabiš računalnik, pametni telefon ali tablico.
Proizvajalci različnih naprav – kamer, pametnih telefonov, tablic – pogosto v svoj izbor programov vključijo tudi
kakšnega za montažo videa. Obstaja vrsta različnih osnovnih programov, ki delujejo na podoben princip. V tem
poglavju bomo predstavili osnovno montažo v programu Adobe Premiere Elements, ki je plačljiv program,
primeren pa je za enostavne in zahtevnejše projekte. Razložili bomo, kako ustvariš projekt, montiraš sliko, dodaš
prehode, naslove, glasbo in off zvok.

 

Vision v akciji – kratek opomnik za delo na terenu
 

• Najdi si ustrezen prostor za montažo, lahko uporabiš slušalke, da lahko nemoteno delaš ne
glede na okolico.
• Preden pričneš z montažo, si oglej ves posneti material, da boš že vnaprej vedel, kateri
posnetki so dobri. Posnetke lahko pregleduješ s katerim koli predvajalnikom videa. Naredi si
zapiske, kateri so ustrezni.
• Preden boš ustvaril projekt v programu za montažo, si dobro organiziraj posnetke v posebej
za ta projekt ustvarjeni mapi. To naredi z Windows Explorerjem ali katerim drugim ustreznim
programom, nato pa jih uvozi v Adobe Premiere Elements in ohrani isto strukturo map tudi v
tem.
• Nauči se bližnjice na tipkovnici, ker si boš s tem olajšal delo. Osnovne bližnjice za Premiere
Elements so:
    ⚬ Shrani projekt: Ctrl + S
    ⚬ Razveljavi en ali več korakov: Ctrl + Z
    ⚬ Izberi vse, na primer vse datoteke in mape v oknu ‘Project elements’ ali vse posnetke na
časovnici (ang. timeline): Ctrl + A
    ⚬ Predvajaj/ustavi video v oknu za predogled: preslednica (ang. spacebar)
    ⚬ Zoom in out na časovnici: + / –
    ⚬ Izbriši en ali več posnetkov na časovnici, ki so označeni: Del
    ⚬ Končaj urejanje teksta: Esc
• Redno se o napredku pogovori z ostalimi člani tvoje ekipe in naredi izboljšave.
• Redno shranjuj (Ctrl + S)!

 Katero opremo potrebuješ

Za montažo boš potreboval:

Program za montažo na računalniku ali aplikacijo za pametni telefon oziroma tablico. Računalnik, pametni
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telefon ali tablica morajo biti precej zmogljivi in morajo imeti ustrezen operacijski sistem, procesor, RAM in
disk. V programu, ki ga boš uporabil, so zapisane minimalne zahteve, da le-ta deluje.
Miška. Če uporabljaš prenosni računalnik, boš zelo težko montiral z uporabo vgrajene miške (trackpad).
Dobre zvočnike ali slušalke (da ne boš motil ostalih, če vas je več v istem prostoru).
Y-adapters za slušalke. Ta je v veliko pomoč, kadar montiraš v dvoje na enem računalniku in ne želiš motiti
drugih.
Če je možno, si priskrbi dodaten ekran, s tem si boš olajšal predogled zmontiranega materiala.

Podrobnejša razlaga

Večina montažnih programov vsebuje naslednji okni:

okno za montažo – v tem oknu sestavljaš svoj film, v njem na časovnico zlagaš posnetke in zvok,
okno za predogled, v tem oknu vidiš, kako izgleda zmontirani film.

Precej težko je najti brezplačen program za montažo, ki je primeren za zahtevnejše projekte. Programi, kot so
Adobe Premiere Elements, Pro CC ali Magix Video Deluxe 15, imajo na voljo brezplačne verzije, uporabljaš jih
lahko mesec dni, a v poskusnem obdobju nimajo vedno na voljo vseh nastavitev.

Program, ki ga bomo opisali v tem poglavju, je Adobe Premiere Elements 13, dostopen je za Windows in Mac iOS
uporabnike. Primeren je tako za enostavne kot za zahtevnejše projekte in podpira vrsto različnih video formatov.
Stane okrog 90 evrov, študenti in izobraževalne ustanove pa lahko dobijo popust.

Manj zahtevne projekte lahko zmontiraš že v programu Movie Maker, ki je za uporabnike operacijskega sistema
Windows na voljo brezplačno. Da se seznaniš, s katerim od drugih programov, si na spletu poišči tutoriale.

Da bomo lažje razložili proces montaže, si predstavljaj, da smo ravnokar posneli video o določenem poklicu.
Snemali smo samo z eno kamero. Material vsebuje intervju z izvajalcem določenega poklica in slikovni material,
v katerem ga vidimo pri delu. Projekt smo poimenovali: Portrait of a professional (slo. Portret profesionalca)*.

* Nekatere termine bomo obdržali v angleškem jeziku zaradi skladnosti z drugimi jezikovnimi verzijami učbenika
in uporabljenimi slikami.

Priprava za montažo

Preden začneš z montažo, moraš urediti svoje posnetke, tako da imaš nad njimi pregled.

Urediš jih lahko v programu Windows Explorer ali kakšnem drugem urejevalniku datotek. Že vnaprej določi,
česar ne potrebejuš, druge posnetke pa uredi npr. po dnevih snemanja ali po prizorih.

Če sodeluješ pri montaži v okviru kakšnega šolskega ali mladinskega projekta in doma nimaš programa
za montažo, si posnetke lahko ogledaš v  programu, kot je Windows Media Player, VLC ali kateri drugi
predvajalnik. Naredi si zapiske o posnetkih (npr. kateri del določenega posnetka ali intervjuja je dober),
ki jih boš kasneje uporabil pri montaži.

Nastavitve tvoje kamere ne bodo vedno kompatibilne z nastavitvami programa za montažo. Če program



posnetkov ne bo mogel uvoziti, se pozanimaj, kakšne formate podpira, in prekodiraj svoje posnetke s katerim od
programov, kot je npr. SUPER (brezplačen) ali Adobe Media Encoder.

Če imaš počasen računalnik, lahko v montaži tudi uporabiš posnetke, ki si jih prekodiral v kak drug format, ki ga
program obdeluje hitreje, kot originalnega, npr. .avi. To narediš s katerim od zgoraj omenjenih programov za
kodiranje, na voljo pa moraš imeti dovolj prostora na disku.

Velika ločljivost posnetkov lahko tudi močno vpliva na hitrost delovanja tvojega računalnika. Posnetke lahko
prekodiraš v takšne z manjšo ločljivostjo in le-te uporabiš v montaži. Ko montažo končaš, uporabljene posnetke
zamenjaj s tistimi z visoko ločljivostjo in nato eksportiraj film. V Adobe Premiere Elements to storiš tako, da
narediš desni klik z miško na uporabljen video, ki ga najdeš v ‘project elements’, nato klikneš ‘replace video file’
in izbereš isti posnetek v visoki ločljivosti**.

**Ker program ni na voljo v slovenski verziji, uporabljamo angleške izraze.

Vse druge datoteke, ki jih boš uporabil v videu poleg posnetkov, kot npr. dodaten zvok, shrani tudi v katero
izmed podmap, ki so v glavni mapi. V primeru našega filmčka Portret profesionalca bo naslov glavne mape
‘Portrait of a professional’, imela pa bo dve podmapi: ‘Interview sequence’ and ‘Sectional images’ (slo. ‘Intervju’
in ‘Slikovni material’), v katere bomo posnetke razvrstili že vnaprej.

Ustvarjanje novega projekta v programu Adobe Premiere Elements 13

Odpri Adobe Premiere Elements.

Izberi Video Editor->New Project.

Odprl se ti bo delovni prostor (delovno okno), v katerem boš montiral svoj video. Klikni ‘Save’ desno zgoraj in
projekt poimenuj: ‘portrait_of_a_professional.prel’. Nato ga shrani v podmapo ‘Premier Elements’, ki jo najdeš v
glavni mapi: ‘Portrait of a professional’.

V drugi vrstici gledano od zgoraj navzdol lahko izbiraš med ‘Quick’ ali ‘Expert’  načinom montaže (slo. ‘hitri
način’ in ‘napredni način’).

‘Quick’ način ti bo ponudil eno vrstico na časovnici za naslove, eno za video (skupaj z vrstico za zvok) in po eno
dodatno vrstico za off zvok in glasbo (vse to boš videl v oknu za montažo). Video (slika) in zvok sta v tem načinu
združena in na voljo nimaš možnosti, da ju med sabo ločiš.

Ta način je primeren za zelo enostavne projekte, v katerih ne potrebuješ več vrstic za video in ko ne rabiš
posebne montaže za zvok.

Poleg tega hitri način tudi ne vključuje v meniju možnosti ‘Project elements’. Brez nje ne moreš natančno videti
vseh videov, ki jih imaš v projektu in je zato pravzaprav tudi že za enostavne projekte bolje uporabiti ‘Expert’
način.

V ‘Expert’ načinu imaš na voljo štiri vrstice za video in tudi za pripadajoč zvok. Za razliko od ‘Quick’ načina lahko
tu zvok posameznih posnetkov montiraš ne glede na video. Meni ‘Project elements’ je tu na voljo, kar pomeni,
da imaš lahko dober pregled nad vsemi datotekami v projektu – video posnetki, naslovi, slikami in grafiko – vse
lepo urejeno.



Naslednja prednost ‘Expert’ načina je, da lahko v njem montiraš material, ki je bil posnet z več kamerami
istočasno, saj lahko z uporabo več vrstic za video sinhroniziraš posnetke. Tako lahko lažje izbereš, katere kote
snemanja izbereš kdaj. Več si poglej v delu ‘Montaža videa z uporabo več vrstic za video’, ki ga najdeš spodaj.

V programu imaš na voljo tudi ‘Wizard Guided Mode’ (slo. vodenje s pomočjo čarovnika). Ta ponuja dodatno
podporo bodisi v ‘Expert’ ali ‘Quick’ načinu in te vodi skozi proces montaže.

Za projekt, ki ga uporabljamo kot primer, ‘The portrait of a professional’, bomo prikazali uporabo programa v
‘Expert’ načinu.

Uvažanje datotek

Gumb ‘Add Media’ (zgoraj levo) ti omogoči, da v svoj projekt uvoziš različne datoteke, npr. iz podatkovnega
diska, kamor si jih shranil, ali iz kamere, če jo imaš povezano na računalnik.

‘Webcam or WDM device’ izbira v meniju ti omogoči, da uvoziš posnetke, ki jih posnameš s spletno
kamero neposredno v Premiere Elements.

Klikni ‘Add Media’->’Files and folders’, izberi ‘Portrait of a professional’, najdi podmapo ‘Interview sequence’.

Izberi ‘Import Folder’, da uvoziš mapo v ‘Project elements’. Ko to storiš, naredi dvojni klik na ‘Interview
sequence’ v ‘Project elements’ oknu in videl boš vse datoteke. Naredi isto za podmapo ‘Sectional images’.

V ‘Project elements’ lahko izbereš način prikaza. To storiš z manjšim gumbom na desni strani okna.

V ”Project elements’ lahko tudi ustvariš nove mape in v nje razporediš videe, v primeru, če tega nisi
storil že prej na računalniku.

Če narediš dvojni klik na posamezno datoteko v ‘Project elements’, se bo pojavilo manjše okno, v katerem si
lahko ogledaš cel posnetek.

Ko veš, kateri del posnetka želiš uporabiti v svojem filmčku, lahko v oknu za predogled, ki si ga odprl z dvojnim
klikom, premakneš kurzor na tisto mesto, kjer želiš, da se posnetek prične, in s klikom na ‘Set In-P’ označiš
začetek izbora. Nato na isti način označi konec, s kurzorjem se premakni na tisti del, kjer želiš, da se posnetek
konča, in klikni ‘Set Out-P’.

Sedaj primi posnetek v oknu za predogled in ga odnesi na časovnico – na časovnici se bo pojavil tisti del
posnetka, ki si ga označil tako, da si mu določil začetek in konec.

Ta metoda je zelo uspešna, če si si posnetke pogledal že vnaprej in si zapisal časovno kodo za vsak posnetek
oziroma za del posnetka, ki ga želiš uporabiti. Tako moraš za vsak posnetek v oknu za predogled označiti, od
kod do kod je uporaben, in ga enostavno potegniti na časovnico.

Če pa si posnetkov poprej še nisi ogledal in označil točne minutaže delov, ki jih želiš uporabiti, lahko to storiš



sedaj v programu, in sicer:

Naredi dvojni klik na mapo ‘Interview sequence’ v oknu ‘Project elements’.
Izberi vse datoteke v mapi. To lahko storiš tako, da držiš tipko ‘Shift’ in klikaš datoteke ali enostavno
pritisneš Ctrl + A.
Prenesi vse posnetke na časovnico.
Začni urejati posnetke drugega za drugim na časovnici.

Uporabi drsnik na dnu okna za montažo, da se premikaš po časovnici naprej in nazaj.

Z gumbom ‘play’ v oknu za predogled boš predvajal posnetke drugega za drugim, kot si jih zložil na
časovnico. Uporabiš lahko tudi preslednico (ang. spacebar), da predvajanje zaženeš ali ustaviš.

Uporabi ikono za koš v ‘Project Elements’, da iz programa zbrišeš posnetke, ki jih ne rabiš. Ne skrbi, izbrisani
bodo le iz programa, ne tudi iz podatkovnega diska, kjer so shranjeni.

Mala ikona za mapo, levo od ikone za koš, ti omogoči, da se premakneš mapo višje.

Uporabiš lahko tudi iskalnik (ikona lupe), da najdeš točno določeno datoteko.

Drsnik na desni strani časovnice ti omogoči zoom in in zoom out. Če izbereš zoom in, lahko zelo
podrobno delaš montažo na majhnem delu posnetka, saj ga vidiš kot zelo velikega. Z zoom out pa
spremeniš pogled in lahko zopet vidiš celoto, torej vse posnetke, ki so zloženi na časovnici.

Zoom in in zoom out lahko tudi izvedeš s pritiskom na tipko ‘+’ ali ‘-‘ na tipkovnici.

Ko si prenesel vse dele posnetkov, ki jih želiš uporabiti (morda boš kak posnetek uporabil tudi v celoti) na
časovnico, lahko pričneš z urejanjem.

Navpična rdeča črta na časovnici se imenuje tudi Current Time Indicator (slo. trenutni kazalnik časa) in ti
pove, na kateri minuti in sekundi tvojega filmčka se nahajaš. Če klikneš na območje malo nad časovnico, se
lahko premikaš na različne dele filmčka. Kazalnik lahko premikaš tudi tako, da ga klikneš in vlečeš levo ali
desno (klikneš in vlečeš lahko tudi modri trikotnik na vrhu).

Z vlečenjem kazalnika boš slišal tudi ves zvok posnetkov; na ta način lahko hitro najdeš določeno mesto,
npr. konec stavka, ko nastopi tišina.

Da na časovnici odrežeš kos posnetka, se s kazalnikom postavi na mesto, kjer želiš, da se konča, in klikni na
majhno ikono škarij, ki jo vidiš zraven. S tem posnetek prerežeš na pol.
Da odstraniš del posnetka levo od reza, ga klikni in izberi gumb ‘Remove’. Ali pa naredi desni klik z miško in
izberi ‘Delete’. S tem bo na tem mestu na časovnici nastala vrzel. Če bi sedaj zmontirane posnetke gledal v
oknu za predogled, bi, ko bi prišel do tega mesta, videl črnino.
Luknjo zapreš tako, da to mesto označiš in narediš na miški desni klik ter izbereš ‘Delete and close gap’. S



tem posnetke, ki so se nahajali pred in po vrzeli, združiš.
Ponavljaj vse korake, dokler ne zrežeš celega intervjuja.

Posnetek na časovnici pa lahko namesto rezanja krajšaš ali daljšaš. Če se postaviš na začetek ali konec
posameznega posnetka, se pojavi rdeč oklepaj z dvema črnima puščicama. Klikni na oklepaj in se premikaj levo
ali desno do želene dolžine, nato ga izpusti.

Kombinacija tipk Ctrl + Z ti dovoli, da razveljaviš zadnji korak, ki si ga naredil, to lahko narediš za 50
korakov nazaj.

Izbira možnosti ‘Protocol’, ki jo najdeš v zgornjem meniju pod ‘Window’, ti pokaže seznam zadnji 50
korakov. Sedaj lahko razveljaviš vse korake do koraka, ki si si ga izbral. Več od 50 korakov pa ni več
prikazano.

Če boš program zaprl, boš to možnost izgubil. Ko ga odpreš ponovno, bo program začel s shranjevanjem
korakov zopet od začetka.

Če nisi prepričan, da so vse spremembe, ki jih delaš, dobre, naredi kopije različnih montažnih verzij z
uporabo ‘File->Save As …’. Tako imaš vedno v spominu starejšo verzijo, če ti tvoj napredek v montaži ni
všeč.

Ne pozabi shraniti vsako verzijo pod svojim imenom. Shranjevanje ti ne bo zasedlo veliko prostora na
disku, saj shranjuješ le projekt, le montažno kombinacijo in ne še enkrat vseh posnetkov.

Slikovni material

Slikovni material je tisti, ki naredi tvoj izdelek zanimiv, poleg seveda razlag, ki si jih dobili ustno s snemanjem
intervjuja.

Iz mape ‘Sectional images’ v oknu ‘Project elements’ dodaj v vrstico Video 2 na časovnici posnetke, ki
prikazujejo tisto, o čemer intervjuvanec govori v intervjuju.
Lahko jih umestiš tako, da prikazujejo točno tisto, kar intervjuvanec govori, ali malo kasneje.
Tako dobi gledalec slišno in vidno informacijo, vendar se ta princip ne uporablja pri vseh formatih, ker
včasih ni primerno, da se slika podvaja z razlago. Če pa intervjuvanec razlaga, npr. kako deluje kakšen stroj,
želi gledalec ta stroj tudi videti.

Prelivi

Najpogosteje delamo čiste reze, vendar pa je možno uporabiti tudi manjše prelive med posnetki, da naredimo
prehode bolj mehke.

Najbolj pogosta vrsta preliva je ‘Cross Dissolve’ (počasen preliv enega posnetka v drugega) in preliv v črno.

Preliv v črno

Preliv (najdeš ga pod ‘Transitions’) lahko potegneš na posnetek tako, da ga primeš in spustiš na mesto, kjer ga



želiš imeti. Obstaja več situacij, v katerih lahko uporabiš preliv v črno:

Na začetku prvega posnetka: večina videov se prične tako, da slika postopno preide iz črnine.
Med dvema posnetkoma: Slika med dvema posnetkoma je za trenutek povsem zatemnjena. S tem lahko
prikažemo, da je minilo nekaj časa ali da se bomo znašli na drugi lokaciji.
Na koncu zadnjega posnetka: na koncu slika postopno preide v črno, kar pomeni, da se je film zaključil.

Prelivi v programu Premiere Elements

Rez med dvema posnetkoma mora biti na časovnici viden, da boš lahko čez umestil preliv.1.
Izberi ‘Transition’ spodaj desno in izberi vrsto preliva. Najbolj pogoste najdeš pod ‘scattering’.2.
Primi in odnesi preliv na rez, kjer ga želiš imeti. Pojavilo se bo okno ‘Transition adjustments’.3.
Izberi, kako naj preliv poteka: naj bo na koncu prvega posnetka, na začetku drugega ali med obema, v4.
zadnjem primeru izbereš ‘between clips’.
Z ‘Duration’ nastaviš dolžino preliva v sekundah.5.

Precej pogosto se ustvarja prehode tudi z vstavljanjem beline, še posebej pri montaži intervjujev. Takšna
belina, ki je vmes med dvema posnetkoma, naj traja zelo kratko (2 sličici – 2 frama).

Najmanjši možni čas, ki ga lahko nastaviš pod ‘Duration’, je 1 sekunda. Če torej želiš vstaviti le kratko
belino, to storiš tako, da greš na Edit-> Preferences-> Set General in nastaviš ‘default duration of video
transition’ na dve sličici – dva frama.

Vstavljanje naslovov, podnapisov in zaključnih napisov

Preden pričneš z vstavljanjem naslovov, podnapisov in izdelavo zaključnih napisov, klikni v oknu za predogled
na desno tipko miške in izberi ‘Secure borders’ (slo. varne meje).

Vsi grafični elementi, ki jih boš vstavljal, naj bodo znotraj teh meja, razen zaključni napisi, ki bodo verjetno
potovali od spodaj navzgor in ven iz ekrana.

Naslovi

Klikni ‘Title and text’ spodaj desno, dobil boš na voljo cel kup prednastavljenih možnosti, celo nekaj animacij.

Za naš filmček ‘Portrait of the professional’ lahko narediš naslednje:

Izberi filmu enostaven naslov, kot na primer Avtomehanik – portret Jožeta Novaka.
Da to storiš, primi ‘Standard Text’ in ga odnesi na ustrezno mesto na časovnici, nekje na začetek, kjer želiš
imeti naslov v vrstico Video 3.
Vijolično okno ‘Default Text’ se bo pojavilo na časovnici. Naredi dvojni klik na njem, da lahko začneš
vpisovati naslov. Pojavilo se bo okno ‘Adjustments’. Tu spremeni font, velikost in poravnavo (zavihek ‘Text’)
ter izberi stil (zavihek ‘Style’).



Podnapisi

Da vneseš podnapis:

Najprej potrebuješ tekst.
Nato ustvari napis in ga vstavi na časovnico na vrstico Video 3 na isti način, kot je opisano zgoraj.
Oblikuj tekst v ‘Adjustments’ oknu.
Pod podnapis lahko vstaviš tudi kakšen grafični element. V zavihku ‘Forms’ izberi in vstavi katerega od
ovalov, pravokotnikov ali črt. Na primer pravokotnik lahko postaviš tako, da pokriva spodnjo tretjino okna.
Oblikuj element po želji.
Poskrbi, da element ne pokriva teksta, to storiš tako, da narediš desni klik z miško na element in izbereš
Arrange-> Send to Back.

Pritisni Escape tipko, da zopet vidiš kurzor in lažje premikaš elemente in tekst.

Zaključni napisi

Na koncu ponavadi dodamo zaključne napise.

Lahko uporabiš klasičen filmski način, pri katerem se napisi premikajo od spodaj navzgor.

Pojdi v ‘Title and Text’ meni in izberi ‘Standard creep’, vstavi ga na odgovarjajoče mesto na koncu filma na
vrstico Video 3 na časovnici in oblikuj, kakor je opisano zgoraj.

Dodajanje glasbe in off zvoka

V ‘Expert’ načinu imaš na voljo dve dodatni vrstici za zvok na časovnici. Ena se imenuje ‘Voice memo’ in je
namenjena za kateri koli dodaten zvok, npr. off zvok za pripoved, druga pa se imenuje ‘Soundtrack’ in je
namenjena za glasbo.

Off zvok lahko posnameš z različnimi snemalniki zvoka ali mikrofonom in ga uvoziš v program v oknu ‘Project
elements’. Preden ga uvoziš, ga lahko tudi ustrezno pripraviš v katerem izmed programov za obdelavo zvoka.

Zmanjševanje in zniževanje glasnosti zvoka:

Razširi svojo vrstico za zvok, tako da klikneš na mali trikotnik na levi strani vrstice. Pojavila se bo rumena1.
črta na zvoku.
Klikni na črto in jo premikaj gor ali dol ter s tem višaj ali nižaj glasnost zvoka, to moraš storiti za vsak2.
posnetek posebej.
Če želiš zvok zmanjševati ali zniževati postopno, naredi naslednje:3.

Postavi kurzor na rumeno črto na mesto, kjer želiš, da se zvok prične spreminjati. Klikni in hkrati pritisni
tipko ‘Ctrl’. Pojavila se bo pika (keyframe).
Povleci piko gor ali dol: poteg dol pomeni, da se bo zvok zviševal postopoma, s potegom gor pa dobiš
obraten učinek.
Vstavi toliko pik, kot jih potrebuješ, da urediš zvok.



Dodatne možnosti

Sedaj že precej veš, veš kako montirati posnetke skupaj na časovnici, rezati, vstavljati napise itd.

Svoje možnosti lahko še razširiš, in sicer lahko dodajaš različne efekte na video in avdio vrstice, efekte za video
najdeš pod ‘Effects’, več efektov za glasbo in zvočne efekte pa poišči pod možnostjo ‘Audio’ (te možnosti najdeš
v oknu za montažo spodaj desno).

Meni ‘Customize’ zgoraj desno ti tudi ponuja nekaj dodatnih možnosti. Uporabiš lahko na primer ‘Intelligent Auto
Color Correction’ (slo. avtomatično korekcijo barv), da med seboj barvno uskladiš posnetke iz različnih kamer.
Razišči in preizkusi še ostale možnosti!

Kodiranje videa v različne formate

Ko boš končal z montažo, se odloči, na kak način želiš video objaviti. Boš izdelal DVD ali video naložil na splet?
To bo namreč vplivalo na to, v kakšen format boš svoj film eksportiral. Več o tem si preberi v poglavju: Kodiranje
za arhiv, splet in zapisovanje na DVD.

Montaža videa z uporabo več vrstic za video

Vzemimo na primer, da si snemal prizor, intervju ali dogodek z več različnimi kamerami hkrati. V načinu ‘Expert’
v Premiere Elements lahko sinhroniziraš (uskladiš) posnetke med sabo in jih ustrezno zmontiraš, tako da hkrati
uporabiš več vrstic za video na časovnici.

Da bo razlaga lažje razumljiva, si predstavljaj, da smo intervju snemali z dvema kamerama po principu plan-
kontraplan.

Najprej si naredi jasen razpored posnetkov na računalniku. Glavna mapa se lahko imenuje na primer:1.
‘Intervju z Jožetom Novakom’ ter ima dve podmapi: ‘Kamera 1’, v tej so posnetki tistega, ki je intervjujal, in
‘Kamera 2’, v kateri so posnetki intervjuvanca. Seveda moraš imeti vmes tudi nekaj posnetkov, kjer se na
sliki vidita oba.
Uvozi podmape v ‘Project elements’. Videl boš (v oknu za montažo) več video vrstic skupaj z zvokom: Video2.
in Audio 1; Video 2 in Audio 2; Video 3 in Audio 3.
Postavi vse posnetke iz ‘Kamera 1’ na vrstico Video 1/Audio 1. Nato odnesi vse posnetke iz ‘Kamera 2’ na3.
vrstico Video 2/Audio 2. Posnetke iz ‘Kamera 1’ smo namenoma postavili na Video 1 in posnetke iz ‘Kamera
2’ na Video 2. Posnetki iz ‘Kamera 1’ so v večini posnetki tistega, ki je intervjuval in jih v končni montaži ne
bomo uporabili veliko, več bomo videli posnetkov intervjuvanca, iz ‘Kamera 2’, ki so na Video 2. Pri montaži
videa je namreč tako, da če imamo dve vrstici za video na časovnici, bomo vedno videli posnetke iz zgornje,
ki je v tem primeru Video 2. Zvok slišimo vedno iz vseh vrstic istočasno.
Če ne vidiš vrstice Video 3, uporabi drsnik na desni strani okna. Na Vrstico Video 3 boš polagal slikovni4.
material, naslove, podnapise …

Kakor smo napisali, sta obe kameri snemali intervju istočasno. Sedaj moraš sinhronizirati posnetke iz obeh
kamer.

To lahko storiš na dva načina:

https://vision.wettintv.de/?page_id=3454
https://vision.wettintv.de/?page_id=3454


Sinhronizacija z uporabo zvoka: Če sta obe kameri snemali zvok, lahko uskladiš posnetke z uporabo zvoka.1.
Idealno bi bilo, če si uporabil klapo ali naredil plosk z dlanmi, da si s tem pomagaš najti začetek posnetka iz
vsake kamere. Lahko pa posnetke sinhroniziraš tudi brez uporabe zvoka. V obeh primerih klikni na
trikotnike na levi strani vsake vrstice za zvok, da ju razširiš, sedaj boš videl na obeh grafični zapis zvoka.
Zapisa bosta zelo podobna, saj sta obe kameri snemali isti prizor. Povečaj si časovnico s ‘+’ na tipkovnici ali
drsnikom zgoraj desno v oknu za montažo, da boš lahko natančneje delal. Poišči zvok klape ali nek začetni
zvok. Nato primi enega od posnetkov (video in zvok) in ga premakni levo ali desno, dokler nista začetna
zvoka na istem položaju, natančno drug pod drugim. Da preveriš, ali je sinhronizacija uspela, predvajaj
posnetka; če nista natančno sinhronizirana, se bo v zvoku slišal odmev.
Sinhronizacija z uporabo videa: Tudi v tem primeru pomaga, če si začetek naznanil s klapo ali ploskom rok,2.
vendar si lahko pomagaš tudi s kakšnim drugim gibom. Poišči isti gib na obeh posnetkih in ju poravnaj
drugega pod drugim tako, da je gib spodnjega in zgornjega približno usklajen. Sedaj razširi vrstico Video 2 s
klikom na trikotnik na levi strani vrstice. Pojavila se bo rumena črta. Klikni nanjo in jo povleci malce dol, s
tem bo postal zgornji posnetek rahlo prosojen in boš istočasno videl tudi spodnji posnetek (na Video 1).
Premikaj posnetek na Video 2 levo ali desno, dokler ne najdeš točne skladnosti s spodnjim posnetkom.
Preveri sinhronizacijo, tako da predvajaš posnetke, in poslušaj, ali je v zvoku kakšen odmev. Če imaš na
voljo samo en zvok, poskušaj zvok uskladiti z odpiranjem ust.

Ko zaključiš s sinhronizacijo vseh posnetkov iz obeh kamer, jih montiraš naprej, kot je opisano zgoraj (režeš,
krajšaš, brišeš …). Bodi pozoren, da se vedno nahajaš na pravem posnetku.

Pogoste napake

Svojega dela ne shranjuješ redno. Če se ti program sesuje, lahko izgubiš veliko dela. Program Premiere
Elements avtomatično shranjuje vsakih 20 minut, tako da lahko tudi v mapi z avtomatičnimi shranitvami
najdeš kakšno prejšnjo shranjeno verzijo, vendar vse, kar je bilo narejeno po zadnjem shranjevanju, ne bo
ohranjeno.
Posnetki se ne nahajajo v isti mapi in podmapah. Če boš posnetke na primer delno prenesel na zunanji disk
in ga izklopil, in potem poskušal predvajati projekt na računalniku, se bodo na mestih, kjer so bili posnetki,
ki si jih prenesel, pojavile črne vrzeli.
Težava lahko nastane tudi, kadar samo ena oseba montira in se o montaži ne posvetuje z ostalimi. Nekateri
člani skupine so lahko nad izdelkom razočarani ali pa mora montažer porabiti še veliko časa za popravke.

Vaje

Najlažje se bo učiti montaže z delom na konkretnem projektu. Uporabi znanje iz tega poglavja in začni!

Sorodne teme in zunanji viri

Poglavja: Zgradba filma / Brezplačni spletni viri / Kodiranje za arhiv, splet in zapisovanje na DVD

https://vision.wettintv.de/?page_id=156
https://vision.wettintv.de/?page_id=909
https://vision.wettintv.de/?page_id=3454


Metodologija

Za mladostnike zna biti precej dolgočasno, če bodo morali dlje časa delati na računalniku, poleg tega lahko
delata montažo, kadar se uporablja slušalke, maksimalno dva hkrati. Skupino lahko razdeliš v manjše skupine in
naj montirajo izmenično, čeprav to vpliva na hitrost in kakovost izdelka. Le tako se bodo vsi udeleženci naučili
uporabljati program. Proces učenja naj bi bil bolj pomemben od končnega izdelka. O napredku se pogovarjajte,
po želji lahko tudi povežete računalnik za montažo s projektorjem, da lahko montažo spremlja več udeležencev
hkrati. Za tiste, ki jih montaža ne zanima, organiziraj dodatne aktivnosti, naredijo lahko npr. plakat za film, drugi
lahko naredijo intervjuje z udeleženci projekta. Prav pride tudi kakšna fizična aktivnost, da si posamezniki
odpočijejo od dela za računalnikom, npr. šport ali gledališka improvizacija.

Terminologija

okno za montažo, okno za predogled, uvažanje posnetkov, kazalnik časa, prelivi, naslovi, podnapisi, zaključni
napisi, sinhronizacija


